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Introduction 

Adding audio and video to a PowerPoint presentation can be very useful, and can make your 

presentation more appealing to your audience. Audio can be added to slides in the form of background 

music, sound effects, or recordings. Video can also be added to a slide and played during your 

presentation. This is a great way to make your presentation more engaging for your audience.   

 

O e your slide show is o plete, you’ll eed to prese t it. This ooklet will tea h you how to prese t 
your presentation and explain how to use the presentation tools. 

 

In PowerPoint 2016, you can insert and playback many different file formats. 

 

Supported audio file formats: 

FILE FORMAT EXTENSION 

AIFF Audio file .aiff 

AU Audio file .au 

MIDI file .mid or .midi 

MP3 Audio file .mp3 

Advanced Audio Coding - MPEG-4 Audio file .m4a, .mp4 

Windows Audio file .wav 

Windows Media Audio file .wma 

 

 

Supported video file formats: 

FILE FORMAT EXTENSION 

Windows Media file .asf 

Windows Video file  

(Some .avi files may require additional codecs) 

.avi 

MP4 Video file .mp4, .m4v, .mov 

Movie file .mpg or .mpeg 

Adobe Flash Media .swf 

Windows Media Video file .wmv 
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Learning Objectives 

Upon completing this documentation, you will be able to: 

 

 Add audio to the slide show 

 Add video to the slide show 

 Edit an audio file 

 Edit a video 

 Set up a slide show 

 Start the slide show 

 Understand how to use the presentation tools and features 
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Audio 

In PowerPoint, you can add audio to your presentation from clipart audio, from a file, or you can 

record audio.  The instructions below explain how to add audio to your slide show using each of these 

methods. 

 

To Insert Audio from a File 

1. In Normal view, navigate to the slide that you want to add audio. 

2. Click the Insert tab on the Ribbon, and then click the Audio button. 

 

 
Figure 1 - Ribbon 

3. From the drop-down list, within the Media group, select Audio on My PC. 

 

 
Figure 2 - Audio on My PC 

4. The Insert Audio window will appear. Navigate to the location of the audio file. 

 

 
Figure 3 - Insert Audio 
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5. Select the audio file, and then click the Insert button. 

6. The audio file will appear on the slide. 

 

To Record Audio 

1. In Normal view, navigate to the slide that you want to add audio. 

2. Click the Insert tab on the Ribbon, and then select Audio. 

 

 
Figure 4 - Ribbon 

3. From the drop-down list, within the Media group, select Record Audio. 

 

 
Figure 5 - Record Audio 

4. The Recorder will appear. Type a name for the recording in the Name field. 

 

 
Figure 6 - Name the Recording 

5. Click the Record button to start the recording. 

 

 
Figure 7 - Record Button 
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6. Click the Stop button when you are finished recording. 

 

 

Figure 8 - Stop Button 

7. To preview your recording, click the Play button. 

 

 
Figure 9 - Play Button 

Note: If you do not like the recording and want to re-record the audio, select the Record button 

again. 

 

8. Once you are done, click OK.  The audio file should appear on the slide. 

 

9. If you do not want to keep the recording, click the Cancel button. 
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The Audio File 

1. Play/Pause – Click the play button to play/pause button to play and pause the audio file (See 

Figure 10). 

2. Timeline – The timeline will advance as the audio plays.  Click anywhere on the timeline to go 

to a different place in the audio file (See Figure 10). 

3. Back – Move back .25 seconds in the audio file (See Figure 10). 

4. Forward – Move forward .25 seconds in the file (See Figure 10). 

5. Timer – View the time for the audio file (See Figure 10). 

6. Volume – Using your mouse, hover over the volume icon to access the slider.  Scroll up to 

increase the volume.  Scroll down to decrease the volume.  Click the volume icon to 

Mute/Unmute the audio file (See Figure 10). 

 

 
Figure 10 - Audio File 

Deleting an Audio File 

1. Navigate to the slide that contains the audio that you would like to delete. 

2. Select the audio file icon. 

3. Press the Delete or Backspace key on your keyboard. 

 

Moving an Audio File 

1. Navigate to the slide that contains the audio that you would like to move. 

2. Click and drag the audio file to the desired location. 
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Playing Background Music Across all Slides 

1. Select the audio file to be played across all slides. 

2. On the Audio Tools contextual tab, select the Playback tab. 

3. Click the Play in Background button. The audio file will now play across all slides until you reach 

the end of the presentation. 

 

 
Figure 11 - Play in Background 

Editing Audio 

Sometimes you may need to make changes to your audio file. The following instructions explain how to 

edit the audio file. 

 

To Trim an Audio File: 

1. Select the audio file that you want to edit. 

2. Click the Playback tab on the Ribbon. 

3. Select Trim Audio. 

 

 
Figure 12 - Trim Audio 
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4. The Trim Audio window will appear. Click and drag the green handle to set the start time  

(See Figure 13). 

5. Click and drag the red handle to set the end time (See Figure 13). 

6. Click the Play button to preview the changes (See Figure 13). 

7. If necessary, adjust the handles again. Once you are done, click OK (See Figure 13). 

 

 
Figure 13 - Trim Audio 

Note:  You can also adjust the start or end time by selecting the green or red handles, and then clicking 

the Previous Frame or Next Frame buttons. 

 

 
Figure 14 - Previous/Next Frame 

To add a Fade In and Fade Out: 

1. Select the audio file that you would like to edit. 

2. Click the Playback tab on the Ribbon. 

3. Under the Fade Duration section, either type in the desired times for the Fade in and Fade Out, 

or use the up and down arrows to adjust the times (See Figure 15). 

 

 
Figure 15 - Fade In/Fade Out 
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Audio Options 

Additional options that control how your audio file will play are found on the Playback tab, in the Audio 

Options group. 

 

1. Volume – Adjust the volume for the audio file (See Figure 16). 

2. Start – Controls whether the audio file starts when you click the mouse, or automatically  

(See Figure 16). 

3. Play Across Slide – Select the checkbox to play the audio file across all slides (See Figure 16).  

4. Loop until Stopped – Select the checkbox to replay the audio file until stopped (See Figure 

16Error! Reference source not found.). 

5. Hide During Show – Select the checkbox to hide the audio file icon while the slide show is 

playing (See Figure 16). 

6. Rewind after Playing – Select this checkbox to return the audio file to the beginning when it is 

finished playing (See Figure 16). 

 

 
Figure 16 - Audio Options 
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Applying an Audio Style 

Once an audio file has been added to your slide, you can format it to make it look more presentable. 

 

1. Select the audio file that you would like to format. 

2. Select the Format tab (See Figure 17). 

3. Hover over the picture styles for a preview of each one (See Figure 17). 

4. Click the style of your choice.  The style will be applied to the audio file. (See Figure 17). 

 

 
Figure 17 - Picture Styles 

Video 

PowerPoint allows you to insert a video on to a slide and play it during your presentation.   You can 

edit the video within PowerPoint using the trim feature, and the fade in/fade out feature.  You can also 

format the appearance of the video. 

 

Inserting a Video from a File 

 

1. Navigate to the slide where you want to insert a video. 

2. Select the Insert tab.  

3. Click the Video drop-down arrow. 

 

 
Figure 18 - Insert Video 
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4. Select Video on My PC. 

 

 
Figure 19 - Video on My PC 

5. Locate the video file, and then click Insert. 

 

 
Figure 20 - Insert Video 

6. The video will be added to the slide. Click and drag the sizing handles to resize the video. 

 

 
Figure 21 - Sizing Handles 
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Inserting an Online Video 

If you choose to inserting an online video, you have the choice to select a video from YouTube or you 

can insert an embed code.  You may also choose to insert a hyperlink to the video. For more 

information on how to insert a hyperlink, see the booklet PowerPoint 2016: Intro to PowerPoint, 

located on the UITS Documentation Center (http://uits.kennesaw.edu/cdoc). 

 

Previewing a Video 

Click the video to select it. 

1. Play/Pause – Click the Play/Pause button to preview the video (See Figure 22). 

2. Timeline – To go directly to a specific part of the video, click anywhere on the timeline (See 

Figure 22). 

3. Back – Move back .25 seconds (See Figure 22). 

4. Forward – Move forward .25 seconds (See Figure 22). 

5. Volume – Using your mouse, hover over the volume icon to access the slider.  Scroll up to 

increase the volume.  Scroll down to decrease the volume.  Click the volume icon to 

Mute/Unmute the video (See Figure 22). 

 

 
Figure 22 - Preview Video 

 

Deleting a Video 

1. Click the video to select it. 

2. Press the Delete or Backspace key on your keyboard. 

3. The video will be removed from the slide. 

 

  

http://uits.kennesaw.edu/cdoc
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Moving a Video 

1. Navigate to the slide that contains the video that you would like to move. 

2. Click and drag the video to the desired location. 

 

Editing a Video 

Sometimes you may need to make changes to your video file. The following instructions explain how to 

edit a video file from your computer: 

 

To Trim a Video 

1. Select the video that you would like to trim. 

2. Click the Playback tab on the Ribbon and select the Trim Video option in the Editing group. 

 

 
Figure 23 - Trim Video Button 

3. The Trim Video window will appear. Use the green handle to set the start time (See Figure 24). 

4. Use the red handle to set the end time (See Figure 24). 

5. Click Play to preview the video (See Figure 24). 

6. Click OK when you are done trimming the video (See Figure 24). 

 

  
Figure 24 - Trim Video 
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Note:  You can also adjust the start or end time by clicking the up or down arrows in the Start Time or 

End Time fields (See Figure 24). 

 

Note: You cannot edit video files that you acquire online. 

 

To Add a Fade In and Fade Out 

1. Select the video that you would like to apply fading to. 

2. Click the Playback tab on the Ribbon, and go to the Fade Duration section. 

3. To adjust the Fade In or Fade Out, either type in the desired time, or use the up and down 

arrow keys. 

 

 
Figure 30 – Fade In/Fade Out 

Video Options 

Additional options that control how your video will play are found on the Playback tab, in the Audio 

Options group. Volume – Change the volume for the video (See Figure 25). 

1. Start – Control whether you want the video to start automatically or when you click your 

mouse (See Figure 25). 

2. Play Full Screen – The video will fill your entire screen while playing (See Figure 25). 

3. Hide While Not Playing – When the video is not playing, it will be hidden (See Figure 25). 

4. Loop until Stopped – The video will replay until it’s stopped (See Figure 25). 

5. Rewind after Playing – When the video has finished playing, it will return to the beginning  

(See Figure 25). 

 

 
Figure 25 - Video Options 
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Applying a Video Style 

1. To apply a video style, select a video in your presentation. 

2. Click the Format tab (See Figure 26). 

3. Use your mouse to hover over a video style to see a preview of the style.   

4. Select the style of your choice (See Figure 26). 

5. The style will be applied to your video (See Figure 26). 

 

 
Figure 26 - Video Styles 

Slide Show Setup Options 

PowerPoint has several options to choose from to set up your slide show. 

1. Select the Slide Show tab on the ribbon (See Figure 27). 

2. Click Set Up Slide Show in the Set Up group (See Figure 27). 

 

 
Figure 27 - Set Up Slide Show 
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3. The Set Up Show window will appear (See Figure 28). 

4. Select your desired options for your presentation (See Figure 28). 

 

 
Figure 28 - Set Up Show 

Hiding a Slide 

If there is a slide that you do not want to show during the Slide Show, PowerPoint offers the option to 

hide a slide. 
 

1. Select the slide that you wish to hide. 

2. Click the Slide Show tab (See Figure 29). 

3. Select Hide Slide within the Set Up group (See Figure 29). 

 

 
Figure 29 - Hide Slide 

4. When presenting your slideshow, the slide will not be seen. 

 

Presenting Your Slide Show 

PowerPoint presentations are meant to be supplemental information, not a script. Review your 

presentation for content and try to avoid reading directly from the slides.  The following instructions 

explain how to present your slide show. 
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Starting the Slide Show 

1. Select the Slide Show tab (See Figure 30).  

2. Click From Beginning to begin the presentation from the first slide or click From Current Slide 

to begin the presentation from the slide which currently appears in the Slide Preview pane  

(See Figure 30). 

 

 
Figure 30 - Start Slideshow 

3. You can advance to the next slide by pressing Enter, the Spacebar, or by clicking the left mouse 

button. You will also notice left and right arrows in the bottom-left corner of the slide. Clicking 

one of these arrows will advance the presentation to the next slide or the previous slide. 

 

4. Pressing the Escape (Esc) key will end your presentation and return you back to the Normal 

View. 

Note: You can also run the presentation from the current slide by clicking the slide show icon 

located on the status bar. 

 

Presentation Tools 

PowerPoint provides tools that are available for use while presenting your slide show.   

 

Once in Slide Show view, icons will appear in the bottom-left corner of your screen (see Figure 37).   

 

  
Figure 31 - Presentation Tools 

  Back - Select the Back button to move to the Previous slide in the slide show. 

 

 Forward - Select the Forward button to move to the Next slide in the slide show. 

 

 Pen Tools - Use the pen tools to make notations on your slides.   
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 See All Slides - To jump to a specific slide, select the See All Slides icon, and then select the slide 

that you would like to go to next. 

 Zoom - Select the Zoom icon to zoom in on a specific area of the slide. 

 

 Black or unblack slide - Allows you to black out a slide during your presentation. 

 

 More - Select the More button for additional features available in PowerPoint.   Select the More 

icon to access the taskbar on your computer.  Having the ability to access the taskbar while in slide 

show view, will allow you to access the Internet or other files or programs during your 

presentation.  Follow the instructions below to access the taskbar. 

 

Pen Tool 

1. Select the Pen Tools icon. 

2. From the menu, select the Pen or Highlighter, and then click and drag the mouse to mark on 

your slides (See Figure 32). 

3. Select Laser Pointer to draw attention to certain parts of the slide (See Figure 32). 

4. Select Eraser to erase a marking on a slide (See Figure 32). 

5. Select Erase All Ink on Slide to erase all of the markings on a slide (See Figure 32). 
 

 
Figure 32 - Presentation Ink Markings Menu 
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More  
 

1. Select the More button (See Figure 33). 

2. In the menu that appears, select Screen (See Figure 33).  

3. Click Show Taskbar (See Figure 33). The taskbar will appear at the bottom of the screen. 
 

 
Figure 33 - More Menu: Show Taskbar 

You can also white out your screen during your presentation.   

 

1. Select the More icon (See Figure 34). 

2. In the menu that appears, select Screen (See Figure 34).  

3. Click White Screen. Your screen will become completely white (See Figure 34). 

 

 
Figure 34 - More Menu: White Screen 

Note: You can also access any of the presenting tools mentioned above, by right-clicking anywhere on 

the screen during your slideshow. 
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Additional Help 

For additional support, please contact the KSU Service Desk: 

 

KSU Service Desk for Faculty & Staff 

 Phone:  470-578-6999 

 Email:   service@kennesaw.edu 

 Website:  http://uits.kennesaw.edu 

KSU Student Helpdesk 

 Phone:  470-578-3555 

 Email:   studenthelpdesk@kennesaw.edu 

 Website:  http://uits.kennesaw.edu 

mailto:service@kennesaw.edu
http://uits.kennesaw.edu/
mailto:studenthelpdesk@kennesaw.edu
http://uits.kennesaw.edu/
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